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1 OVERVIEW 

1.1 Background 

Leaf area index (LAI) is a useful proxy variable for numerous other variables of ecological interest 
including plant biomass, plant productivity, forage quality, carbon balance, ecosystem energy flux, plant 
density, and the heterogeneity of plant cover. LAI is also used widely as a key input variable to models 
that seek to predict ecological processes such as carbon cycling. Regional to continental scale estimates 
of LAI are typically derived from satellite data, but validation of satellite data with aircraft and ground-
collected data is relatively uncommon. By leveraging NEON’s aircraft and ground-collected estimates of 
LAI, it will be possible to develop ground-validated estimates of LAI at the continental scale. 

There are numerous methods available for estimating LAI, and these fall into two general categories: 
direct and indirect. Direct methods are conceptually the most straightforward, and involve the 
destructive harvest and measurement of individual leaves from selected plants. Direct methods are also 
laborious relative to indirect methods, and as such, are not suitable for further consideration given the 
budgetary and logistical concerns that these methods pose at the continental scale of the Observatory. 
With indirect methods, on the other hand, it is possible to rapidly and non-destructively estimate LAI 
using a variety of optical instruments that measure the canopy gap-fraction, and then mathematically 
relate the gap-fraction to LAI. 

NEON is using the Digital Hemispherical Photo (DHP) system (aka fisheye photos) to estimate LAI, since it 
is rapid and non-destructive. The image-derived gap-fraction (i.e., the proportion of visible sky, un-
obscured by vegetation, calculated as a function of the direction of sky relative to image center) of a 
DHP is then used to calculate LAI. The benefits of using a DHP system include: 1) measurements of LAI in 
systems with tall woody stems are economical and efficient for field technicians to carry out; 
2) measurement of low-stature vegetation – e.g. short-grass steppe – is possible without interfering with 
the vegetation itself during data collection; 3) because the Level 0 data produced by the DHP method is 
in the form of an image file, it is straightforward to perform QA/QC both in the field and at NEON HQ; 
and 4) as data analysis algorithms evolve in the future, digital images are readily archived and can easily 
be re-analyzed for LAI by the user community as desired. 

1.2 Scope 

This document provides a change-controlled version of Observatory protocols and procedures.  
Documentation of content changes (i.e. changes in particular tasks or safety practices) will occur via this 
change-controlled document, not through field manuals or training materials. 



 Title: TOS Protocol and Procedure: Measure of Leaf Area Index Date:  11/03/2014 

NEON Doc. #:  NEON.DOC.014039 Author: C. Meier Revision:  E 

 
 

 2014 NEON Inc. All rights reserved. 
 

Page 2 of 65 

1.2.1 NEON Science Requirements and Data Products 

This protocol fulfills Observatory science requirements that reside in NEON’s Dynamic Object-Oriented 
Requirements System (DOORS). Copies of approved science requirements have been exported from 
DOORS and are available in NEON’s document repository, or upon request. 

Execution of this protocol procures samples and/or generates raw data satisfying NEON Observatory 
scientific requirements. These data and samples are used to create NEON data products, and are 
documented in the NEON Scientific Data Products Catalog (RD[03]). 

1.3 Acknowledgments 

N/A 

2 RELATED DOCUMENTS AND ACRONYMS 

2.1 Applicable Documents 

Applicable documents contain higher-level information that is implemented in the current document. 
Examples include designs, plans, or standards.  

AD[01] NEON.DOC.004300 EHS Safety Policy and Program Manual 
AD[02] NEON.DOC.004316 Operations Field Safety and Security Plan 
AD[03] NEON.DOC.000724 Domain Chemical Hygiene Plan and Biosafety Manual 
AD[04] NEON.DOC.001155 NEON Training Plan 
AD[05] NEON.DOC.050005 Field Operations Job Instruction Training Plan 
AD[06] NEON.DOC.000914 TOS Science Design for Plant Biomass, Productivity, and Leaf Area 

Index 
AD[07] NEON.DOC.014051 Field Audit Plan 
AD[08] NEON.DOC.000824 Data and Data Product Quality Assurance and Control Plan 

2.2 Reference Documents 

Reference documents contain information that supports or complements the current document. 
Examples include related protocols, datasheets, or general-information references. 

RD[01] NEON.DOC.000008 NEON Acronym List 
RD[02] NEON.DOC.000243 NEON Glossary of Terms 
RD[03] NEON.DOC.005003 NEON Scientific Data Products Catalog 
RD[04] NEON.DOC.001271 NEON Protocol and Procedure: Manual Data Transcription 
RD[05] NEON.DOC.001575 Datasheets for TOS Protocol and Procedure:  Measurement of Leaf 

Area Index 
RD[06] NEON.DOC.001398 NEON Raw Data Ingest Workbook for TOS Digital Hemispherical Photos 
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2.3 Acronyms 

Acronym Definition 
CV Coefficient of Variation 
DHP Digital Hemispherical Photo 
DOY Day of Year 
DSLR Digital Single Lens Reflex [camera] 
LAI Leaf Area Index 
NDVI Normalized Differential Vegetation Index (a proxy for vegetation greenness) 
PAI Plant Area Index 

2.4 Definitions 

N/A 

3 METHOD 

There are two high-level components to this LAI data collection protocol, which serve to capture LAI 
data across space and through time : 1) data are collected on the ground every 3-6 years from 
Distributed and Gradient plots, and these data are used in conjunction with AOP LAI data products to 
estimate LAI at the site scale; and 2) data are collected every two weeks from a subset of Tower plots 
(n=3) that will be used to construct a time-series dataset that will complement the spatially-extensive 
snapshot of LAI generated from AOP data.  

The plotIDs for the Distributed and Gradient plots that will be used for LAI sampling will be provided by 
Science Operations. In order to speed data collection from Tower Plots, those selected for LAI 
measurement should be the three plots that are closest to, or most readily accessed from, the TIS 
Tower, as determined by Field Operations. For more details of the LAI spatial and temporal sampling 
strategy, see the Plant Biomass and Productivity Science Design (AD[06]). 

Digital hemispherical photos are taken at 12 points within each of the specified plots, and these photo 
points radiate outward from the plot center in the cardinal directions (Figure 1). Collection of quality LAI 
data with a DHP system at each point-location is highly dependent on taking the hemispherical photos in 
appropriate light conditions, and on properly exposing the images. If vegetation is on average shorter 
than shoulder height, downward-facing images will suffice for a given plot (Table 9). Otherwise, upward-
facing images are also required to properly capture LAI for the plot. In the laboratory, image files are 
processed with Adobe Photoshop to adjust image size and ensure that leaf elements are properly 
exposed. Sets of 12 images are then analyzed using CanEye (http://www6.paca.inra.fr/can-eye/) 
software to generate plot-level and point-level LAI estimates. 
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Figure 1. Distributed base plot (or 20 m x 20 m Tower plot) showing the 
location and spacing of DHP photo points relative to plot center; grey numbers 
represent subplotIDs. 

A critical component of image analysis in CanEye is the classification of pixels into plant and non-plant 
categories. In order to ‘calibrate’ pixel classification across different technicians, technicians performing 
the CanEye analysis will analyze a standard set of images provided by Science Operations before 
proceeding to analyze additional images. The standard image set will be analyzed at least three times in 
order to calculate a CV for the individual technician. The CV must be < 10%, and the mean LAI value 
produced by the technician with this standard image set must be within ± 10% of the LAI value provided 
for the standard image set before the technician may proceed to analyze additional images. The CV is 
calculated as follows: 

𝐶𝐶 =  
𝜎
𝜇

 ×  100,𝑤ℎ𝑒𝑒𝑒 𝜎 = 𝑠𝑠𝑠𝑠𝑠𝑠𝑠𝑠 𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑, 𝑎𝑎𝑎 𝜇 = 𝑡ℎ𝑒 𝑚𝑚𝑚𝑚 

Standard Operating Procedures (SOPs), in Section 7 of this document, provide detailed step-by-step 
directions, contingency plans, sampling tips, and best practices for implementing this sampling 
procedure. To properly collect and process samples, field technicians must follow the protocol and 
associated SOPs. Use NEON’s problem reporting system to resolve any field issues associated with 
implementing this protocol. 

The value of NEON data hinges on consistent implementation of this protocol across all NEON domains, 
for the life of the project. It is therefore essential that field personnel carry out this protocol as outlined 
in this document. In the event that local conditions create uncertainty about carrying out these steps, it 
is critical that technicians document the problem and enter it in NEON’s problem tracking system.  
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The procedures described in this protocol will be audited according to the Field Audit Plan (AD[07]). 
Additional quality assurance will be performed on data collected via these procedures according to the 
NEON Data and Data Product Quality Assurance and Control Plan (AD[08]). 

A combination of hot, cold, and blind checks will be used to ensure that quality hemispherical images 
are collected in the field, images are repeatably taken from the same locations in each plot, and that 
images are analyzed properly with the CanEye software. 

4 SAMPLING SCHEDULE 

4.1 Sampling Frequency and Timing 

The frequency and timing of DHP image collection depends on whether Distributed/Gradient plots will 
be sampled, or whether Tower plots will be sampled (Table 1). 

Table 1. Number of plots and frequency of sampling guidelines for DHP collection in Distributed/Gradient and Tower plots. 

Plot type Plot 
Number Sampling Events Yearly Interval 

Distributed/ 
Gradient plot n=20 1X per sampling year Every 3-6y. One site per domain per year 

(or every other year) 

Tower plot n=3 Every 2 weeks (approx. 14 events 
per year) Annual 
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4.2 Criteria for Determining Onset and Cessation of Sampling 

Onset and cessation of DHP image collection depends on whether Distributed/Gradient plots will be 
sampled, or whether Tower plots will be sampled (Table 2). 

Table 2. Number of plots and sampling start/stop guidelines for DHP collection in Distributed/Gradient and Tower plots. 

Plot type Plot 
Number Sampling Start Sampling Stop 

Distributed/ 
Gradient plot n=20 

Up to 2 weeks before AOP flight 
date (or beginning of flight date 
range)1 

Up to 2 weeks after actual AOP flight 
date 

Tower plot n=3 
Start of growing season, as new 
leaves and needles become visible 
and begin to expand2 

Whichever is first: 
1. DOY > 305 (1st November) 

2. Site-specific NDVI returns to pre-
growing-season level3 

1 Provided the flight date (or range of possible dates) is confirmed and not subject to change more than ± 1 week. If no AOP 
flight is scheduled in a given year, postpone ground LAI sampling at Distributed and Gradient plots to the next year in which an 
AOP flight is scheduled. The annual schedule for AOP flights is provided by Science Operations RD[08], and Domain Managers 
should communicate with AOP managers to keep abreast of current flight plans. 
2 Based on multi-year averages; dates provided by Field Operations. 
3 Determined by Science Operations. 

It is the responsibility of Field Operations to determine the exact timing of sampling within a given day. 

4.3 Timing for Processing and Analysis 

DHP images collected in the field may be processed for LAI with Photoshop and CanEye any time after 
images have passed automated QA/QC tests. However, it requires approximately 30-60 min per plot to 
process and analyze the images (depending on whether 12 or 24 images were taken per plot), so it is 
good practice not to amass a large volume of un-analyzed images. 
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4.4 Sampling Timing Contingencies 

When unexpected field conditions require deviations from this protocol, the guidance provided here 
must be followed to ensure that basic data quality standards are met (Table 3). 

Table 3. Contingent decisions 

Delay/Situation Action Outcome for Data Products 

Hours 

If 1) Delay interrupts data collection mid-plot: 
a) stop data collection for the plot, and delete 
any images taken; b) upon resuming, ensure 
light conditions are favorable; and c) repeat 
data collection for entire plot on the same day 
if possible. 

A delay of hours can lead to poor light 
conditions for collection of LAI data. This 
can lead to overestimation or imprecise 
estimation of LAI. 

If 2) Delay occurs between plots: a) Ensure light 
conditions are favorable for data collection; 
and b) resume data collection for next plot. 

A delay of hours can lead to poor light 
conditions for collection of LAI data. This 
can lead to overestimation or imprecise 
estimation of LAI. 

1-7 days 

If 1) Delay interrupts data collection mid-plot: 
a) stop data collection for the plot, and delete 
any images taken; b) on the next possible 
sampling day within 7 days of the delay, ensure 
light conditions are favorable; and c) repeat 
data collection for the plot. 

None 

If 2) Delay occurs between plots: a) Return to 
the field ASAP; b ) ensure light conditions are 
favorable for data collection from an entire 
plot; and c) resume data collection for the next 
plot. 

None 

8+ days 

If 1) Delay interrupts data collection mid-plot: 
a) stop data collection for the plot, and delete 
any images taken; b) skip sampling for current 
boutID and continue sampling as part of the 
next boutID. 

Decreased sample size resulting in 
imprecise estimation of LAI. 

If 2) Delay occurs between plots: a) skip 
sampling for current boutID and continue 
sampling as part of the next boutID. 

Decreased sample size 
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5 SAFETY 

This document identifies procedure-specific safety hazards and associated safety requirements. It does 
not describe general safety practices or site-specific safety practices. 

Personnel working at a NEON site must be compliant with safe field work practices as outlined in the 
Operations Field Safety and Security Plan (AD[02]) and EHS Safety Policy and Program Manual (AD[01]).  
Additional safety issues associated with this field procedure are outlined below.  The Field Operations 
Manager and the Lead Field Technician have primary authority to stop work activities based on unsafe 
field conditions; however, all employees have the responsibility and right to stop their work in unsafe 
conditions. 

Personnel working at a NEON site must be compliant with safe field work practices as outlined in the 
Operations Field Safety and Security Plan (AD[02]) and EHS Safety Policy and Program Manual (AD[01]).  
Additional safety issues associated with this field procedure are outlined below.  The Field Operations 
Manager and the Lead Field Technician have primary authority to stop work activities based on unsafe 
field conditions; however, all employees have the responsibility and right to stop their work in unsafe 
conditions. 

Because DHP images are often collected in the field at dawn or dusk, it is advisable to bring a headlamp 
to aid navigation between plots. 

Make sure headlamp is turned off during data collection! 
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6 PERSONNEL AND EQUIPMENT 

6.1 Equipment 

The following equipment is needed to implement the procedures in this document. Equipment lists are organized by task. They do not include 
standard field and laboratory supplies such as charging stations, first aid kits, drying ovens, ultra-low refrigerators, etc. 

Table 4. Equipment list – A team of two people collecting DHPs from a plot 

Item No. R/S Description Purpose 

Q
ua

nt
ity

 

Sp
ec

ia
l 

Ha
nd

lin
g 

Durable items 

MX104649 R DSLR camera body Acquire DHP images 1 N 

MX104651 R Hemispherical fisheye lens Acquire DHP images 1 N 

MX104654 R DSLR memory card, 16 Gb Store DHP images in the field; one in camera, one for backup 2 N 

MX104653 R DSLR battery One in camera, one for backup 2 N 

 R Camera and lens carry case Protect camera equipment in the field 1 N 

 R Camera monopod Hold camera steady away from body 1 N 

 R Compass with mirror site, 
declination adjusted Orientation for finding photo points 1 N 

 S Microfiber lens cleaning cloth Clean lens; paper lens cleaning tissues may also be used 1 N 
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Item No. R/S Description Purpose 

Q
ua

nt
ity

 

Sp
ec

ia
l 

Ha
nd

lin
g 

 S GPS unit, pre-loaded with plot 
locations Aids in navigating to and finding plots 1 N 

 S Headlamp Sight aid in low-light conditions 2 N 

 S Rangefinder Estimate overstory height 1 N 

Consumable items 

RD[05] R LAI field datasheet Record sampling event metadata Varies N 

 R Pencils Record sampling event metadata 2 N 

R/S=Required/Suggested 
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Table 5. Equipment list –Transferring DHPs from the camera to the server, and handling field-collected sampling metadata 

Item No. R/S Description Purpose 

Q
ua

nt
ity

 

Sp
ec

ia
l 

Ha
nd

lin
g 

Durable items 

MX104654 R DSLR 16Gb memory card Contains field-collected DHPs 2 N 

MX104657 R DSLR memory card reader Transfer images from memory card to server following 
sampling event 1 N 

 R Laptop with USB port Connect to DSLR card reader and NEON Domain server 1 N 

Consumable items 

RD[05] R Completed LAI field datasheets Contains field-collected DHP metadata Varies N 

R/S=Required/Suggested 
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Table 6. Equipment list – Batch processing DHPs  

Item No. R/S Description Purpose 

Q
ua

nt
ity

 

Sp
ec

ia
l 

Ha
nd

lin
g 

Durable items 

 R Adobe Photoshop (version CS5 or CS6 are suitable) Perform batch resize, shadow adjust, format conversion  1 N 

 R Virtual machine running on Domain Lab server Hosts installation of Photoshop on Domain Lab server 1 N 

Consumable items 

(None)      
R/S=Required/Suggested 

Table 7. Equipment list – Processing JPG images with CanEye software 

Item No. R/S Description Purpose 

Q
ua

nt
ity

 

Sp
ec

ia
l 

Ha
nd

lin
g 

Durable items 

 R CanEye (current version) with associated Matlab 
libraries 

Calculate plot and point-level LAI from JPG images. 1 No 

 R Virtual machine running on Domain Lab server Hosts installation of CanEye on Domain Lab server. 1 No 

Consumable items 

(None)      
R/S=Required/Suggested 
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6.2 Training Requirements 

All technicians must complete required safety training as defined in the NEON Training Plan (AD[04]). 
Additionally, technicians must complete protocol-specific training for safety and implementation of this 
protocol as required in Field Operations Job Instruction Training Plan (AD[05]). 

Technicians must also be trained to configure, use, and care for the DSLR system when acquiring high-
quality hemispherical photos. 

Technicians should be trained to properly use a mirror-site compass, including looking up and setting the 
appropriate declination. Declination changes with time at each site, and should be looked up annually at 
http://www.ngdc.noaa.gov/geomag-web/. Additionally, being able to repeatedly pace off accurate 
distances in the field will speed collection of LAI data considerably, compared to laying out a meter tape 
in two directions for guidance at each plot. 

Finally, technicians must be trained to process DHP image files with both Adobe Photoshop and CanEye 
software. Before technicians analyze any DHP images, image processing technique must be evaluated 
according to the QA criteria in Section 5 on a per technician basis using standard image sets provided by 
Science Operations. 

6.3 Specialized Skills 

For image acquisition in the field, it is required that one technician have a proficient, working knowledge 
of manual image exposure, and evaluation of image exposure with the specified camera hardware. 
Technicians must become familiar with camera hardware and techniques to obtain proper image 
exposure prior to data collection in the field. Field technicians must also know how to use a mirror-site 
compass.  

For analysis of DHP images to calculate LAI, at least one technician is required, and technician(s) must be 
able to distinguish between yellow, purple, and grey colors. Prior to image analysis with the specified 
software, it must be verified that the technician is capable of analyzing images within specified QA/QC 
parameters (see above). 

6.4 Estimated Time 

The time required to implement a protocol will vary depending on a number of factors, such as skill 
level, system diversity, environmental conditions, and distance between sample plots. The timeframe 
provided below is an estimate based on completion of a task by a skilled two-person team (i.e., not the 
time it takes at the beginning of the field season). Use this estimate as framework for assessing 
progress. If a task is taking significantly longer than the estimated time, a problem ticket should be 
submitted. 

http://www.ngdc.noaa.gov/geomag-web/
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Taking a set of upward- and downward-facing DHPs: Approximately 15 minutes or less per plot. 

Exposure adjustment in Adobe Photoshop: Approximately 10 minutes or less for a batch of 12 upward- 
or downward-facing images from a plot. 

Analysis of DHP images in CanEye software: Approximately 20 minutes, and no more than 30 minutes, 
to analyze a batch of 12 upward- or downward-facing images from a plot. These time estimates are 
assuming the CanEye software does not crash and will allow you to analyze 12 images at once. Should 
CanEye crash, the time required will increase. 
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7 STANDARD OPERATING PROCEDURES 

SOP A Preparing for Sampling 

1. Prepare equipment and materials as specified in Table 4. 
2. Configure the DSLR for DHP image acquisition according to settings listed in Appendix E. 

Table 8. Desired Nikon D800 DSLR settings for collecting DHPs in the field. See Appendix E for more detailed instructions for 
operating the Nikon D800. 

Camera 
Parameter Desired Setting How to Change 

Image quality RAW, compressed 
Bit-depth = 12 

“QUAL” button, primary 
wheel 

White balance Auto (A) “WB” button, primary wheel 

Shutter Mode Single shot (S) Left knob, outer ring 

Metering Mode Matrix Back knob, upper-right 

Focus Mode Auto-area Auto Focus (AF-S auto) Focus switch/button, primary 
and secondary wheels 

Playback display 
options Overview Playback Menu 

File naming DXX (where XX is NEON Domain number) Shooting Menu 

Color space sRGB Shooting Menu 

Active D-lighting Auto Shooting Menu 

High ISO NR Normal Shooting Menu 

ISO sensitivity 
settings 

Auto-ISO sensitivity control = ON; 
Maximum sensitivity = Hi2; Minimum 
shutter speed = 1/30 

Shooting Menu 

Time Zone and 
Date 

Time Zone = Domain specific 
Date and Time = Current local (24h format) 
Date Format = Y/M/D 
Daylight Savings = current local 

Setup Menu 
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A.1 Scheduling the field day 

The following timing considerations arise with respect to collecting high-quality LAI data on a given day: 

• DHP images should not be collected when water droplets will form on the lens (i.e. it is raining, 
misting, there is heavy condensation, etc.). Check the local weather forecast prior to initiating 
field work to ensure that data collection will be possible. 

• Upward-facing DHPs must only be collected when direct sunlight is NOT visible on the foliage 
– i.e. an approximately 45 min period at dawn or dusk, or any time during the day when it is 
sufficiently overcast such that a person does not cast a visible shadow. 

• Downward-facing DHPs may be collected either with or without sunlight on the foliage. 
However, DO NOT take downward-facing images either before the sun has come up or after 
the sun has set: low-light makes it difficult to distinguish green from brown colors during image 
analysis. 

• On a given measurement day, plan on arriving at the location of the first plot to be measured at 
least 20 minutes before light conditions are appropriate. 

A.2 Prepare equipment 

The following preparatory actions may need to be taken: 

• Micro-fiber lens cleaning cloth: Clean soiled cloth if necessary. 
• DSLR fisheye lens: Clean with lens cloth if necessary. 
• DSLR batteries: Charge. 
• DSLR 16Gb memory card: Empty memory cards of pre-existing images. 
• GPS unit: Charge and load target plot locations. 
• Headlamp: Check batteries. 
• Compass: Check/set correct declination.  

o Declination changes with time and should be looked up annually per site: 
http://www.ngdc.noaa.gov/geomag-web/). 

• Meter tape: Calibrate technician pacing: determine # paces equivalent to 4 m (distance 
between photo points).  
o Being able to repeatedly pace off accurate distances in the field will speed collection of LAI 

data considerably, compared to laying out a meter tape in two directions for guidance at 
each plot. 

• LAI field datasheets (RD[05]):Print. 
o The LAI field datasheet is provided as a companion document, and is intended as an interim 

data collection medium until a BioPDA application is available. 

  



 Title: TOS Protocol and Procedure: Measure of Leaf Area Index Date:  11/03/2014 

NEON Doc. #:  NEON.DOC.014039 Author: C. Meier Revision:  E 

 
 

 2014 NEON Inc. All rights reserved. 
 

Page 17 of 65 

SOP B Field Sampling: Preparing to Collect DHPs from a Plot 

Keep an eye on lighting conditions. They may change while images are being acquired.  

B.1 Determining camera orientation and height 

• To decide which combination of camera orientation and camera position are required for a 
given plot, visually survey the vegetation structure in the entire plot and refer to Table 9. 

• Keep in mind that the camera orientation and camera position may change throughout the year 
for a given plot if fast-growing herbaceous plants are present – e.g. in tall-stature grasslands, 
croplands, etc. 

• Record the visually-estimated average understory and overstory vegetation height for the 
entire plot in the LAI field datasheet (RD[05]). Record “understoryHeight” to the nearest 0.1 m 
and “overstoryHeight” to the nearest 1 m (Note:  A rangefinder may be used for this purpose, 
but is optional as the accuracy is not required for this purpose). 

Table 9. Guidelines for determining proper camera positioning when taking DHPs. 

Understory 
Vegetation1 

Overstory 
Vegetation 

Required Camera 
Orientations Camera Position2 

Protocol 
Reference 

Majority < 0.75–
1m height None Single downward-facing 

photo per point Shoulder height SOP C 

Majority > 0.75–
1m height 

None, or 
Majority < 3 m 
height 

Single upward-facing 
photo per point Ground level SOP D 

Majority < 0.75–
1m height 

Majority > 3 m 
height 

Upward and downward-
facing photos per point Shoulder height SOP C & 

SOP D 

Majority > 0.75–
1m height 

Majority > 3 m 
height 

Two upward-facing 
photos per point 

One at shoulder 
height, one at ground 
level 

SOP C 

1>50% of vegetation is characterized by the specified height criteria 
2 See Figure 5 for an example of a researcher holding a camera at shoulder height 
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SOP C Field Sampling: Downward-Facing DHPs 

C.1 Image acquisition guidelines 

• Place backpacks and other gear outside the plot and out of the potential field of view of the 
camera. 

• Configure the camera for acquiring downward-facing DHPs according to the settings specified in 
Table 10. Consult Appendix E for detailed instructions on how to configure the Nikon D800. 

Table 10. Camera settings for downward-facing DHPs 

Camera 
Position 

Exposure 
Mode Focus ISO Shutter Aperture 

Shoulder 
height 

Aperture 
priority (A) 

Auto-area 
Auto Focus 

ISO-auto = ON 
Initial = 400 

Open no longer 
than 1/30 s 

> f/5.6 best, f/4 okay; 
no lower than f/4 

• Take DHPs along the cardinal axes that bisect the plot in the following sequence (Figure 1): 
o 1st : North axis 
o 2nd: East axis 
o 3rd: South axis 
o 4th: West axis 

• Along each cardinal plot axis, always take DHPs at photo-points in the following sequence 
Figure 1): 
o 1st: 2m photo-point 
o 2nd: 6m photo-point 
o 3rd: 10m photo-point 

• Keep the camera perpendicular to the ground at all times. If the terrain at an individual photo-
point is sloped, tilt the camera so that the photo is taken as close to perpendicular to the slope 
as possible. 
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C.2 Taking downward-facing DHPs 

1. Use a declination-corrected mirror-sight compass and calibrated pacing to locate the target 
photo point. Make sure that no ferrous metal objects are within at least 50 cm of the compass 
at all times. 

2. Visually assess the distance between the lens and the vegetation. Foliage should be ≥ 50cm from 
the lens; if foliage is < 50cm from the lens: 
a. Select an alternate spot as close as possible (< 1 meter, perpendicular to the axis) to the 

designated photo-point. 
b. If (a) is not possible, consider taking upward-facing photos (SOP D) instead of downward-

facing photos. 

If foliage is within 0.5 m of camera lens, select an alternative location as close to photo point as 
possible. 

3. Adjust the camera for proper image exposure: 
a. Look through the viewfinder while aiming the lens at the ground. 
b. Push the shutter-release button half-way until a “beep” ” is heard, indicating the camera has 

achieved focus lock and has determined the correct shutter speed. 
c. Adjust the f/stop value so it is as high as possible, but do not allow the shutter to be open 

longer than 1/30 s. 
4. Place the monopod at shoulder height with the lens facing down. 
5. Stand on the cardinal axis at the selected photo location. To minimize inclusion of trampled 

vegetation in the photo, point the camera/monopod perpendicular to the cardinal axis (either 
direction). 

• Choose a direction so that the photographer’s shadow is not in the image. 

6. Keep the camera so that the lens is as close to perpendicular to the ground as possible. 
7. Focus the lens every time you change camera position. Press the shutter release button half 

way. You should hear a “beep” indicating the camera has achieved focus lock. 
8. Carefully press the shutter release button the rest of the way to take the photo. 
9. Check the photo for quality: 

• Make sure the image is not blurry. 
• Check that appropriate shutter speed and f/stop values were obtained. 
• If necessary, delete and re-shoot until a satisfactory image is taken (see Figure 2). 
• If it is not possible to obtain an image with f/stop > 4 and with the shutter open less than 

1/30 s, collect DHPs when more light is available. Unlike upward-facing DHPs, downward-
facing DHPs may be taken with direct sunlight on the foliage. 
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10. Fill out the LAI field datasheet as images are acquired so that sampling metadata and image file 
data may be linked to specific pointIDs and plotIDs. 

• bout: a two digit number assigned by Field Operations. For Tower plots, bout begins with 
bout = 01, and increments throughout the season each time the designated Tower plots are 
photographed. For Distributed/Gradient plots, bout = 00. It is Field Operations responsibility 
to assign the correct bout number. 

• pointID: value is derived from the cardinal direction of the plot axis (i.e. N, S, E, W) plus the 
distance from the plot-center to the photo-point in meters. Examples: N2, E10, etc. 

• cameraOrientation: value = D; where D = downward-facing 
• cameraPosition: value = S; where S = shoulder height 
• imageType: value = U; where U = understory. Record “U” for all downward-facing images, 

even if there is no overstory vegetation (e.g. grassland, cropland). 
• associatedMedia: value = image file name (e.g. D01_0001) 
• remarks: value = notes relevant to image; e.g. “moved 1m E of photo-point” 

11. Proceed to the next photo-point, and return to step 1. 

 
Figure 2. Example of a properly exposed downward-facing DHP at the D01 
Harvard Forest site (photo by B. Chemel). It is normal for a technician’s feet and 
a portion of the legs to be included in the photo. These will be masked out 
during image analysis. 
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SOP D Field Sampling: Upward-Facing DHPs 

D.1 Image acquisition guidelines 

• Place backpacks and other gear outside the plot and out of the potential field of view of the 
camera. 

• Configure the camera for acquiring upward-facing DHPs according to the settings specified in 
Table 11. Consult Appendix E for detailed instructions on how to configure the Nikon D800. 
These settings allow as much light as possible to be recorded by the camera while still enabling 
capture of a “good” quality image. Guidelines for modifying these settings are provided in the 
SOP below. 

Table 11. Initial camera settings for upward-facing DHPs. Settings may be adjusted after a test image is acquired 

Camera 
Placement 

Exposure 
Mode Focus ISO Shutter Aperture 

Shoulder height Manual (M) Manual, set to “∞” ISO-auto = OFF 
Initial = 6400 1/30 s f/5.6 

Ground level Manual (M) Auto-area Auto Focus ISO-auto = OFF 
Initial = 6400 1/30 s f/5.6 

• Take DHPs along the cardinal axes that bisect the plot in the following sequence (Figure 1): 
o 1st : North axis 
o 2nd: East axis 
o 3rd: South axis 
o 4th: West axis 

• Along each cardinal plot axis, always take DHPs at photo-points in the following sequence 
(Figure 1): 
o 1st: 2m photo-point 
o 2nd: 6m photo-point 
o 3rd: 10m photo-point 

• Keep the camera perpendicular to the ground at all times. If the terrain at an individual photo-
point is sloped, tilt the camera so that the photo is taken as close to perpendicular to the slope 
as possible. 

• When upward-facing photos are taken with the camera at ground level, minimize disturbance to 
the vegetation as the camera is placed into position. 
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D.2 Taking Upward-Facing DHPs 

1. Use a declination-corrected mirror-sight compass and calibrated pacing to locate the target 
photo point. Make sure that no ferrous metal objects are within at least 50 cm of the compass 
at all times. 

2. Find a position at or as close to the photo-point possible with distinct sky and foliage elements 
overhead and acquire a test image. The goal is for the sky to be minimally saturated white, with 
foliar elements as dark as possible – i.e. the image should show high contrast between leaves 
and sky, but without overly bright sky “bleeding through” and washing out small leaves and 
needles. 
a. Configure the Nikon D800 as indicated in Table 11. 
b. Looking through the camera viewfinder, point the lens straight up toward the canopy, and 

press the shutter-release button half way to activate the viewfinder light meter. 
c. With the lens still pointing up, adjust the f/stop, shutter speed, and ISO according to Table 

12 until the built-in light meter indicates proper exposure. 

Table 12. Strategy for optimizing image exposure while taking upward-facing DHPs in manual exposure “M” mode 

Exposure 
Problem 

Histogram 
White Peak Optimization Steps (in order of preference) 

Too much light Too high 
Increase f/stop up to f/16 
Decrease time shutter is open to 1/60s 
Decrease ISO and/or further decrease time shutter is open. 

Too little light Too low 
Increase ISO to Hi1 or Hi2 (ISO 12800 or 25600) 
Decrease f/stop to f/4 
If still unacceptable, light conditions are too poor. 

d. Press the shutter-release button all the way down to take the test image. 
3. Check the test image exposure results. 

a. Press the “Play” button on the back of the camera to review the test image in the large LCD 
screen. 

b. Select the “histogram” view using the up/down arrow buttons. 
c. Check the white saturation levels in the test image. White saturation levels appear as a very 

thin peak at the right of the histogram – the height of this peak should be between ¼ – ¾ of 
the potential height (Figure 3). 
• If the exposure is too bright, the white peak will reach the top of the histogram graph. 
• If the exposure is too dark, there will be little or no white peak on the right side of the 

histogram. 
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4. If necessary, adjust the exposure according to Table 12 and take another test image until a 
correctly exposed image is produced (Figure 4). Tips for adjusting exposure: 
a. Higher f/stops reduced light to the sensor, greater depth of field. 
b. Shutter open for less time  reduced light to sensor, better ability to “freeze” motion and 

avoid blurriness associated with subject motion. 
c. Lower ISOsensor is less sensitive to light; below 6400 means images will not have “noise” 

artifacts. 
5. At the designated photo-point, visually assess the distance between the lens and the vegetation. 

Foliage should be ≥ 50cm from the lens. If foliage is < 50cm from the lens: 
a. Select an alternate spot as close to the designated photo-point as possible. 
b. If (a) is not possible, consult the “Troubleshooting” section of this SOP. 

6. Stand on the cardinal axis at the selected photo location. For upward-facing photos taken at 
ground level, minimize inclusion of areas with trampled vegetation near the cardinal axis by 
pointing the camera/monopod into undisturbed vegetation perpendicular to the cardinal axis 
(either direction). 

7. Place the monopod either at shoulder height or on the ground (Figure 5). 
8. Orient the camera so that the lens is as close to perpendicular to the ground as possible. 
9. Press the shutter-release button carefully, to avoid moving the camera too much. 
10. Check the photo for quality: 

• Make sure histogram white saturation values are appropriate. 
• Make sure the image is not blurry. 
• Check that appropriate shutter speed and f/stop values were obtained. 
• If necessary, delete and re-shoot until a satisfactory image is taken (see Figure 4). 
• If it is not possible to obtain an image with f/stop > 4 and with the shutter open for less than 

1/30 s, collect DHPs when more light is available. 

11. Fill out the LAI field datasheet as images are acquired so that camera placement metadata and 
image file names may be linked to specific pointIDs and plotIDs. 

• bout: a two digit number assigned by Field Operations. For Tower plots, bout begins with 
bout = 01, and increments throughout the season each time the designated Tower plots are 
photographed. For Distributed/Gradient plots, bout = 00. It is Field Operations responsibility 
to assign the correct bout number. 

• pointID: value is derived from the cardinal direction of the plot axis (i.e. N, S, E, W) plus the 
distance from the plot-center to the photo-point in meters. Examples: N2, E10, etc. 

• cameraOrientation: value = U; where U = upward-facing 
• cameraPosition: value = S, G, or O; where S = shoulder height, G = ground level, and O = 

other. If value = O, report camera height in “remarks” field. 
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• imageType: value = U or O; where U = understory and O = overstory. Use “U” for images 
taken at ground level, and “O” for images taken at shoulder height. 

• associatedMedia: value = image file name (e.g. D01_0001) 
• remarks: value = notes relevant to image; e.g. “moved 1m E of photo-point” or 

“cameraPosition was 0.5 m” 

12. Proceed to the next photo-point and return to step 1. 

 
Figure 3. An example histogram from a properly exposed 
image. The red, green, and blue histograms are shown in their 
respective colors, and a combined luminance histogram is 
shown in white. 

 
Figure 4. An example of a properly exposed upward-facing DHP taken at the 
NEON D01 Harvard Forest site. 
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Figure 5. A field researcher acquiring an 
upward-facing DHP with the 
monopod/camera ensemble held at 
shoulder height 

D.3  Troubleshooting 

Table 13. Common issues encountered during acquisition of upward-facing DHPs, and available solutions. 

Issue Encountered Camera 
Placement Solution(s) 

1) f/stop < 4 and/or 
2) Shutter open longer than 1/30 

s 

Shoulder height 
or Ground level 

Collect DHPs when more light is available, and 
ensure direct sunlight is NOT on the foliage. 

Vegetation is < 50 cm from the 
lens at the photo point, and there 
is no nearby location where 
vegetation is ≥ 50 cm from the 
lens. 

Shoulder height 

Preferred: Lower the camera height until foliage 
is ≥ 50 cm from the lens. Record alternate photo 
height in “Notes” column of field datasheet. 

Second choice: Maximize the distance between 
the foliage and lens. Record alternate photo 
height and distance to foliage in “Notes” column 
of field datasheet. 

Vegetation is < 50 cm from the 
lens at the photo point. Ground level None. This issue cannot be avoided with DHPs 

acquired under these conditions. 
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SOP E Post-Field- Sampling Tasks 

E.1 DHP handling 

1. Attach the DSLR card reader to the laptop, and make the NEON Domain Lab Server available. 

• Consult the NEON IT department for instructions for connecting to the Domain Lab server. 

2. On the Domain Lab server, create the following folders and sub-folders if they do not exist 
already: 

\\...\LAI_data\LAI_RAW_images\YYYY\boutID\plotID\imageType 

where: 

• YYYY = the current year 
• boutID = XXXXZZ, where XXXX is the unique 4-letter NEON site code, and ZZ = bout # from 

the LAI field datasheet; bout # = 00 for Distributed or Gradient plots. Field Operations is 
responsible for keeping track of and creating the correct bout # for Tower Plots. 

• plotID = a separate sub-folder for images from each plot 
• imageType = a subfolder named either “understory” or “overstory” 

3. Copy images from the camera card to the folders just created on the NEON Domain Lab server 
according to Table 14. 

Table 14. Criteria for determining placement of DHP images within required file path and 
folder structure. 

Camera Orientation Camera 
Position File Path 

Downward Shoulder …\boutID\plotID\understory 

Upward Ground …\boutID\plotID\understory 

Upward Shoulder …\boutID\plotID\overstory 

4. After successfully copying all of the images from the sampling event to the NEON Domain Lab 
server, images files on the camera memory card may be deleted. 
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E.2 Data Handling 

Data recorded in the LAI field datasheet (RD[05]) must be transcribed into a spreadsheet for ingest into 
NEON’s Cyberinfrastructure (CYI). There should be one Excel file containing Leaf Area Index data ingest 
sheets (RD[09]). This file contains at least the following spreadsheets: 

• dhpTableSummary_in: Table briefly describing the purpose of each data ingest table, and 
indicating the measurement resolution for data that are entered. 

• dhpFieldSummary_in: For each field in each ingest table, provides a description, data type, 
ingest validation rule, indication of null acceptability, and example data entry.  

• dhp_perplot_in: Data and metadata recorded on a per plot, per bout basis. 
• dhp_perimagefile_in: Data and metadata linking DHP file names to plotID, pointID, camera 

orientation, camera position, image type, and per image remarks. 

1. Transcribe data from the header table on the LAI field datasheet into the “dhp_perPlot_in” 
ingest table. 

• Consult the “dhpFieldSummary_in” table to determine appropriate values and formats for 
each field, and to see correctly formatted examples. 

• Create “boutID” in XXXXZZ format, where XXXX = 4-letter siteID code, and ZZ = the “bout” 
number recorded on the LAI field datasheet. 

2. Transcribe data from the main table on the LAI field datasheet into the “dhp_perImageFile_in” 
ingest table. 

• Consult the “dhpFieldSummary_in” table to determine appropriate values and formats for 
each field, and to see correctly formatted examples. 

E.3 Refreshing the Sampling Kit 

• Check battery levels on the DSLR LCD screen; recharge if necessary. 
• Recharge batteries on the GPS unit. 
• Clean the micro-fiber cloth, if necessary. 

E.4 Equipment Maintenance, Cleaning and Storage 

• Clean the hemispherical lens with a clean micro-fiber cloth or paper lens cleaning tissue, if 
necessary. 
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SOP F Batch Processing DHPs with Photoshop 

Important: The following SOP should only be performed on DHP images that have passed through 
QA/QC tests described in the NEON DHP QA/QC Algorithm and Theoretical Basis Document (ATBD). 
Tests described in the ATBD will be carried out by the NEON CyberInfrastructure.. Field Ops will receive 
an automatically generated report indicating when directories of DHPs have passed through the ATBD. 

Once DHP images have been processed through the QA/QC ATBD (conducted on the Domain Lab 
server), DHPs in RAW image format (.NEF) must be resized, adjusted to improve visible detail in 
shadows, and converted to JPG format for analysis in CanEye. 

F.1 Creating a Photoshop Batch Processing “Droplet” 

In Photoshop, a “Droplet” is an icon onto which files can be dragged, dropped, and then processed 
according to a standard set of actions encoded in the Droplet. Following the instructions below, you will 
create a Droplet that processes DHP RAW files into JPG files with Quality = 10 (out of 100).  

1. Login to the virtual machine on the Domain Lab server that runs Adobe Photoshop, and make 
available the share that is used for DHPs copied from the camera. 

2. Select a test image file – either upward or downward-facing. Create a test image by copying a 
DHP file to the Desktop. 

• It is important that the test image is exposed similarly to the .NEF images for which 
processing is desired. 

3. Open Adobe Photoshop. 
4. Make sure the “Actions” pane is visible: from the drop-down menus click “Window → Action” 

(Alt-F9). 
5. Within the “Actions” pane, create a new set of actions by clicking the folder icon at the bottom 

of the pane, and name the new action set “CanEye processing”. 
6. Create a new action within the “CanEye processing” set by clicking the “Create New Action” 

button at the bottom of the pane (post-it icon).  
7. Name the new action “RAW to JPG Q10”. Click “OK” to begin recording the new action – from 

this point onward, until you click the “Stop” button at the bottom of the Action pane, Photoshop 
will record everything you do as part of the new action. 

• The “Q10” indicates the JPG files will be generated with quality set to 10 out of 100, which 
should be a relatively small, low-quality JPG image. 

8. Open the test image file: “File → Open” 



 Title: TOS Protocol and Procedure: Measure of Leaf Area Index Date:  11/03/2014 

NEON Doc. #:  NEON.DOC.014039 Author: C. Meier Revision:  E 

 
 

 2014 NEON Inc. All rights reserved. 
 

Page 29 of 65 

9. In the “Camera RAW” plug-in that opens with the image, adjust the exposure using the sliders in 
Table 15 below. The goal is to obtain good tonal information and detail in darker areas of the 
image, and avoid losing information in any very bright, highly exposed portions of the image. 

Table 15. Sliders and their effects in the “Basic” panel of Adobe Camera Raw1. 

Slider Effect Reason to Use 

Exposure Adjusts brightness of mid-tones to 
shadows 

Image is underexposed across the 
tonal range 

Contrast Adjusts contrast of mid-tones, some 
shadows, some highlights 

Detail in a broadly mid-tone range 
are washed out 

Highlights Manipulates tonal values for the upper 
¼ of the image tonal range 

Decreasing highlights can bring out 
detail in an overexposed sky 

Shadows Manipulates tonal values for the lower 
¾ of the image tonal range 

Brings out color tones and detail 
previously cloaked in shadow 

Whites Manipulates the very brightest white 
pixels in the image. 

Image contains highly overexposed 
areas. 

Blacks Manipulates the very darkest black 
pixels in the image. 

Image contains deeply 
underexposed areas. 

Clarity Adjusts contrast on image mid-tones, 
but not shadows and highlights 

Improves the ability to discern fine 
details in the image. 

1 Multiple droplets may be created in order to accommodate variation in image exposure for image sets taken at different 
times of day, or with different shadow strengths, etc. 

10. To adjust the size of the photo, click the link at the bottom of the Camera RAW window that 
states the image size, and in the “Workflow Options” window that opens, make the following 
selections, then click “OK”: 

Table 16. Image parameters 

Parameter Desired Setting 

Space sRGB IEC61966-2.1 

Depth 8 bits/channel 

Size 2048 x 1368 pixels (2.8 MP) 

Resolution 240 pixels per inch 

Sharpen for None; amount = standard 
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11. In the Camera RAW window, click “Open Image” in the bottom-right. 
12. Verify that the image has changed size by clicking “Image → Image size” from the drop-down 

menus. Click “OK”. 
13. Select “File → Save for web”, which will open a new “Save for Web & Devices” window. In the 

top-right of this window, select “Quality = 10”. 
14. Click “Save”, and save the image to the Desktop. 
15. When saving is complete, click “Stop Recording” at the bottom of the Photoshop “Action” pane. 
16. To create the Droplet, select “File → Automate → Create Droplet” and name the Droplet “RAW 

to JPG Q10 [light condition]”; where [light condition] = dusk, strongShadowsDay, 
softShadowsDay, etc. (when unique light conditions arise for which existing droplets do not 
produce images with acceptable exposure, define the light condition in a useful manner; e.g. 
“dusk” may be broken out into “closedCanopyDusk” and “openCanopyDusk”. Note: camelCase 
has been suggested here as a naming convention to be consistent with data ingest sheets, but is 
not required.  

17. Click “Save”. The Droplet can be saved to the Desktop for ease of use, or to any other location. 
18. A new menu will appear requesting you to assign an Action to the Droplet. Select the Action that 

you just created above. 
19. Check the “Override action ‘Open’ commands” box. This ensures that Photoshop will batch 

process photos without opening the Camera RAW plugin. 
20. Set the destination folder. 

a. First create a “Batch Output” folder on the Desktop. 
b. Select the “Batch Output” folder as the destination. 

21. Check the “Override action ‘Save as’ commands” box. 
22. Set the file naming scheme so that the original file names are preserved. 
23. The Droplet will now be saved to your Desktop and be available for use. 

F.2 Processing DHP Images with a Photoshop Droplet 

1. To batch process a group of 12 RAW .NEF images from: 

\\...\boutID\plotID\imageType\ 

First create a create a subfolder in “imageType” named “processed”. 

2. Select .NEF photos from the “imageType” folder within Windows Explorer, and drag onto the 
Droplet. Processed JPG photos will appear in the “Batch Output” folder. 

3. Check batch processed images to determine whether the Droplet created satisfactory JPGs 
(Table 17). 
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Table 17. Details to examine in JPG images created via batch process from DHP RAW images. 

Camera 
Orientation Potential Issue 

Downward 

Inability to distinguish green leaves from soil, litter, rocks, etc. in areas 
of strong shadow. 

Inability to discern fine detail in mid-tones 

Overexposed areas lacking tonal detail – i.e. photos of a grassland 
taken during the day. Difficult to distinguish green from other colors in 
everexposed areas. 

Upward 

Inability to distinguish green leaves from underexposed sky in areas of 
strong shadow. 

Inability to discern fine detail in mid-tones 

Inability to distinguish leaves from sky in overexposed areas 

4. If processed images are satisfactory, move processed images from “Batch Output” to: 

\\...\boutID\plotID\imageType\processed\ 

5. If processed images are unsatisfactory, create a Photoshop droplet (or use a different existing 
one) that will produce a quality test image, and re-process the batch of .NEF files. A subset of 
images may also be re-processed if desired. 
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SOP G Analyzing JPG Images for Lead Area Index with Caneye Software 

Important: The following SOP should only be performed on DHP images that have passed through 
QA/QC tests described in the NEON DHP QA/QC Algorithm and Theoretical Basis Document (ATBD). 
Tests described in the ATBD will be carried out by the NEON CyberInfrastructure team. Field Ops will 
receive an automatically generated report indicating when directories of DHPs have passed through the 
ATBD. 

Once DHP images have been processed through the QA/QC ATBD (which will be conducted on the 
Domain Server), use CanEye software to analyze the overstory and understory photos from a given plot 
in separate batches. 

It is necessary to analyze a minimum of 8 distinct images per batch in CanEye. The software makes 
assumptions about the distribution of canopy gaps in the images, and these assumptions are violated 
when the image sample size drops below n=8. Images will first be analyzed in batches of n=12, and 
sample size will be reduced only if necessary (details on which images to exclude are provided below). 

G.1 Starting and parameterizing CanEye 

The following steps are performed each time images are analyzed in CanEye. Do not reuse existing 
parameter files from past sessions. 

1. Login to the virtual machine on the Domain Lab server that runs CanEye image analysis 
software. 

2. Launch CanEye using the “Run as Administrator” command. To do this, R-click on the CanEye 
program icon and select “Run as Administrator”. 

3. From the menu bar, select “Hemispherical Images → RGB images”, and then select either 
“Upward” or “Downward,” depending on the type of images to be analyzed. 

• The program may indicate “No directory selected” and return to the launch screen. This is a 
known bug, and if this happens, simply re-select the image type according to the step above, 
and a “Browse for Folder” window will appear. 

4. Select the directory containing the JPG images to be analyzed. A “Can-Eye Parameterization” 
window will appear. The generalized directory path will be: 

\\...\boutID\plotID\imageType\processed\ 

5. In the “comment” field, enter the following: 

• boutID 
• plotID 
• “overstory” or “understory”, depending on imageType 
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6. In the “Calibration Parameters” portion of the window, click “Create” under “Optical Center and 
Projection Function”. DO NOT reuse a pre-existing Calibration Parameter file. In the window 
that opens, enter the following values, then click “OK”: 

Table 18. Creating the optical center and projection function for LAI analysis in CanEye. 

Field Field Description Desired Value 

Lines Pixel number corresponding to the 
image center (vertical direction) 

Lines = (Total vertical pixel #)/2; 
Lines = 1363/2 = 681.5 for a 2048 x 1363 
pixel JPG 

Columns Pixel number corresponding to the 
image center (horizontal direction) 

Columns = (Total horizontal pixel #)/2; 
Columns = 2048/2 = 1024 for a 2028 x 
1363 pixel JPG 

Projection Function 
Slope 

The relationship between zenith 
angle (y-axis) and column pixel # (x-
axis) 

For an image with 2048 px showing a 
180˚ zenith view: 
Slope = 180/1024 = 0.08789 

7. Returning to the “Calibration Parameters” window, enter the following values, overwriting 
existing values where necessary: 

• COI (Circle of Interest) = 75˚ 
• For “Angular Resolution”, Azimuth = 5˚ 

8. Enter the day-of-year (DOY) the images were collected. 
a. Obtain the correct date by checking the file creation date on one of the RAW (.NEF) image 

files.  
b. Convert the date from YYYY-MM-DD format to DOY by checking: http://www-

air.larc.nasa.gov/tools/jday.htm  
9. Enter the latitude (nearest 0.1 degrees) of the site at which images were collected. Latitude can 

be estimated using Google Earth and the current version of the NEON site .kmz file. 
10. Click “Save”. A window will open as the images are processed. 
11. Click “Save” parameter file. 
12. A grid of images will appear. Click “OK”, and proceed to “Image Masking” below. 

G.2 Image Masking and Color Reduction 

Ultimately, you will assign image pixels to three categories: green, sky/soil, and mixed. In this step, you 
will mask features in each DHP image that do not fit into these categories (see masking guidelines in 
Table 19). 
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Table 19. Elements in each DHP that should be masked prior to LAI estimation with CanEye. 

Camera Orientation Masking Guidelines 

Downward 

Mask “large”, vertically oriented trunks, boles, stems, or branches. Look at the 
edges of the photos for vertical stems. 

Photographer’s feet, plot markers/flags, other objects that are neither 
litter/soil/rock nor green plant matter. 

DO NOT mask understory leaves that are attached to overhanging branches. 

Upward 

Mask “large” trunks in each image. 

Stop masking an individual trunk BEFORE it becomes difficult to discern trunk 
from branches and leaves. 

Both 

Stay within the boundary of the element being masked in order to avoid 
masking sky, soil, or green plant matter. 

“Large” is relative: use time as a guide. Do not spend more than 1 min per 
image masking trunks. 

TO CREATE MASKS USING CANEYE: 

1. On the screen with the grid of open images, click the “Select” button at the bottom. Then click 
on the first image to which you want to apply masks, and click “Mask”. 

2. Choose the first object to mask. 
a. L-click around the perimeter of the object to create the mask.  
b. R-clicking will close the mask polygon and complete the mask. 

3. Continue masking objects in the selected image until: 
a. All “large” objects are masked, or 
b. 1 min has elapsed 

4. Click “Done” in the bottom ribbon after masking is complete. You should return to the gridded 
display screen showing all the images in the set. 

5. Repeat steps 1 through 4 for each image in the set, as needed. 
6. Select “Done” from the bottom ribbon. 

• A color reduction process bar appears. When processing is done, a new window opens. 
• Be patient… the processing takes time. When done, the “Class Definition” window opens. If 

after 15 min this window does not open: 
o Proceed to step (7). 
o Otherwise, once the “Class Definition” window opens, proceed to step 8. 
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7. If CanEye has crashed, it appears to depend on the total amount of masked area, and/or the 
total number of masks created. The solution is to reduce the number of images analyzed, one at 
a time: 

• Randomly remove an image from one of the 2m photo-points (i.e. N2, E2, S2, or W2) and 
return to step 1 under G.1, “Starting and parameterizing CanEye”. 

• If the crash re-occurs, remove another randomly selected 2m photo-point image, and try 
again. 

• You may remove the photos from all 4 of the 2m photo-points, but DO NOT analyze fewer 
than n=8 images. 

• If images are removed from the analysis, record the pointID associated with the removed 
images in the “remarks” field of the “lai_plot” ingest sheet. 

• If CanEye crashes with n=8 images, record “NA” in the “laiPlot” field of the “lai_plot” ingest 
sheet, and note “CanEye crash” in the “remarks” field. 

8. In the “Class Definition” window, select “This Option” from the right-hand pane, and click 
“Done”. 

• An array of images with a color grid on the right will appear. This is the “Classification 
Window”. 

9. Set the colors used to represent pixels classified into “Soil” (or “Sky”) and “Green” classes. 
Colors are chosen so that they stand out in relation to background colors. To assign a color: 
a. Click on a category box (i.e. “Soil” or “Sky”, or “Green”). DO NOT click on either the round or 

square radio buttons on either side of the box. A color strip window opens. 
b. Click on the desired color. The following colors provide good contrast with multiple 

backgrounds: 

• Soil/Sky = Yellow or Orange 
• Green = Purple 

10. Proceed to either G.3 (Downward-facing image pixel classification) or G.6 (Upward-facing image 
pixel classification). 
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G.3 Downward-facing image pixel classification 

The procedures for processing downward- and upward-facing images, although similar, have some 
critical differences. To process upward-facing images, follow the procedure in G.6 (Upward-facing image 
pixel classification). 

Pixel classification is an iterative process, in which you move back and forth classifying pixels into either 
the “Green” or “Soil” categories (Table 20). In these directions, we will begin with “Green” plant matter, 
but you may begin with soil if you prefer. See digital tutorial “Classifying Pixels” for a demonstration of 
assigning pixels to classes in CanEye. 

Table 20. Guidelines for classifying pixels into “Green” and “Soil” categories in downward-facing images. 

Pixel Category Qualifying Material 

Green 
Live leaves, needles, green moss, and flowers 

Other material capable of performing photosynthesis 

Soil 

Lichen, brown moss, litter, downed woody debris 

Bare soil, rocks 

Other material not capable of photosynthesizing 

Senesced leaves (yellow, orange, brown) that are on the ground or still 
attached to stems. 

G.4 Classifying pixels as green or soil 

1. First, zero-out pre-classification of pixels into the “Soil” category. 
a. Click on the round radio button to the left of the “Soil” box. This opens the “Class Pre-

classification” window. 
b. In the “Class Pre-classification” window, move the “Brightness Index” option slider all the 

way to the left, to a value of 0.000 
c. Click “OK”. 

2. L-click on one of the images in the grid; it does not matter which one. 
3. Zoom in (L-click) on a leaf or dense leafy area in the image. 

• Zoom in until individual pixels are clearly visible and the entire screen is filled with the leaf. 

4. Select the radio button next to “Green.” 
5. L-click on the lots of pixels in the image that are unambiguously plant matter (this should be 

everything on your screen if you zoomed in on a leaf). 
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• You do not need to be systematic in your L-clicking. By randomly clicking on pixels that are 
all part of the leaf, you will have selected a variety of the true colors that should be 
classified as “Green.” 

6. R-click to apply the purple color to the selected pixels.   

• CanEye automatically assigns all pixels in the entire set of images with the same color to the 
“Green” class. 

• The category boxes (lower right) keeps a tally of the percent of pixels assigned to each class. 
• The color palette (upper right) shows the true colors placed into the “Green” class in the 

region bounded by purple lines on three sides and a gray line on the bottom.  

7. Zoom out to verify that your classification makes sense for the entire image. Use “Select All” to 
verify that it also makes sense for all the images in the set.  

8. Repeat steps 2 through 7, zooming in on different parts of multiple images until all obvious and 
unambiguous plant leaf pixels are classified as “Green.” 

9. After classifying the obvious/easy plant elements, classify the obvious and unambiguous soil 
elements. Proceed in the same manner as for plant matter (steps 2 through 8 above). 

G.5 Strategies for classifying additional pixels 

After classifying the easily identifiable plant and soil elements in an image set, finding additional pixels 
to classify can be difficult. The strategies below will aid in identifying and classifying additional pixels. 
See the digital tutorial “Classifying Pixels” for demonstrations on using these techniques. In general, it is 
best to err on the side of caution: Classify a pixel/color as “Mixed” rather than misclassify it as “Soil” 
or “Green”. 

1. Look closely at the edges of foliage for pixels to assign to “Green” or “Soil” classes. 

• Toggling back and forth between true colors and classified colors is a good way to locate 
unassigned pixels. 

• Move your head (or angle of computer screen) to change the angle of your view – colors 
look a little different at different angles. 

2. Use the color palette to identify colors to move from “Mixed” to either the “Green” or “Soil” 
class. 

• For example, look at the colors in the “Green” class, then look for similar colors that are in 
the “Mixed” class. These are good candidates for colors to move in the “Green” class. 

• Focus particularly on colors with red dots, as these represent the greatest number of pixels 
in the image set. 
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3. Look at all the images in a set: There may be a group of easily classified pixels in one image that 
is not present in the other images. 

4. Look at the color palette. Does anything look out of place? If yes, move it to the “Mixed” class, 
and be conservative.  

5. Look carefully at commonly misclassified colors that are often mistakenly placed in the “Soil” or 
“Green” class (rather than “Mixed’). In particular: 

• Greenish, even olive to drab olive colors in the “Soil” class. 
• Grays and browns in the “Green” class.  

It may be helpful to toggle back and forth between true colors and classified colors to identify 
suspect areas. 

6. To move a color that has been assigned to “Soil” or “Green” back to the “Mixed” class: 

• Select round radio button next to “Mixed.” 
• L-click on suspect true color(s) in the color palette. 
• R-click. 
• Repeat as needed. 

7. Determining when you are finished with pixel classification: 
a. Keep an eye on the percent of pixels assigned to the “Mixed” category. Once “Mixed” pixels 

represent between 15%-20% of the total, classification is complete. 
b. Click “Done” at the bottom of the image grid. 
c. Click “Yes”. 

• A series of computations occur. When computations are complete, the screen returns to 
the CanEye launch screen. 

• LAI results from the image analysis are stored in a subfolder located in the folder with 
DHP images that was initially selected. 

G.6 Upward-facing image pixel classification 

The procedures for processing downward- and upward-facing images, although similar, have some 
critical differences. To process downward-facing images, follow the procedure in the “Downward-facing 
Image Pixel Classification” section. 

Pixel classification is an iterative process, in which you move back and forth classifying pixels into either 
the “Green” or “Sky” categories (Table 21). In these directions, we will begin with “Green” plant matter, 
but you may begin with sky if you prefer. See digital tutorial “Classifying Pixels” for a demonstration of 
assigning pixels to classes in CanEye. 
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Table 21. Guidelines for classifying pixels into “Green” and “Sky” categories in upward-facing images. 

Pixel Category Qualifying Material 

Green 

Live leaves, needles, green moss, and flowers 

Other material capable of performing photosynthesis 

Twigs, branches, and “small” trunks that were not previously masked 

Senesced leaves (yellow, orange, red, brown) still attached to living stems 

Sky Open sky, clouds 

G.7 Pre-classifying sky pixels 

Classifying pixels in a set of upward-facing images begins with pre-classification of sky pixels. Pre-
classification provides a first cut at classifying pixels as sky. The goal is to assign pixels that are CLEARLY 
and UNAMBIGUOUSLY sky to the “Sky” category. You will then refine the auto-classification performed 
in this step by manually classifying additional pixels. 

1. L-click on one of the DHP images. 
2. Zoom in on an area in the image that has lots of sky as well as some small branches and leaves.  

• Zoom in until the image is only slightly pixelated and leaves and branches are still easily 
discerned -- two L-clicks is typically enough. 

3. Click on the round radio button to the left of the “Sky” box. This opens the “class pre-
classification” window. 

4. On the “class pre-classification” window, move the “Brightness Index” option slider all the way 
to the right, for a value of 1.000. 

• It is helpful to move the window so that it does not cover the DHP image. 

5. Adjust the slider, moving it in small increments to the left. 

• As you move the slider, pixels that are classified as “Sky” will be highlighted in orange (or 
whatever color you selected for the “Sky” class). Keep nudging the slider to the left. 

• When it appears that pixels that are not sky (i.e., branches or leaves) are becoming orange, 
back off the slider and click “OK.” 

Note: Once you click “OK” the “pre-classification” window can only be re-opened by clicking the 
“reset” button (on the bottom ribbon), which undoes all classifications. 

6. Click “Display All” on the bottom ribbon. 
7. Check that pre-classification produced satisfactory results for ALL images. 
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G.8 Classifying pixels as green or sky 

1. L-click on one of the images in the displayed grid; it does not matter which one. 
2. Zoom in (L-click) on a leaf, dense leafy area, or stem in the image. 

• Zoom in until individual pixels are clearly visible and the entire screen is filled with the 
selected plant matter.   

3. Select the radio button next to “Green.” 
4. L-click on the numerous pixels in the image that are unambiguously plant matter.  

• If you zoomed in on a stem so that it fills the entire screen, you do not need to be 
systematic in your L-clicking. By randomly clicking on pixels that are all part of the stem, you 
will have selected a variety of the true colors that should be classified as “Green.” 

• For dense leafy areas, you need to be more intentional with your L-clicking. The lighter/light 
gray pixels may be sky filtering through the leaves. If in doubt, do not classify a pixel as 
“Green,” leave it in the “Mixed” class. (See series of images on page 24 for an example of 
classifying pixels in a dense leafy area.) 

5. R-click to apply the purple color to the selected pixels.   

• CanEye automatically assigns all pixels in the entire set of images with the same color to the 
“Green” class. 

• The category boxes (lower right) keep a tally of the percent of pixels assigned to each class. 
• The color palette (upper right) shows the true colors placed into the “Green” class in the 

region bounded by purple lines on three sides and a gray line on the bottom.  

6. Zoom out to verify that your classification makes sense for the entire image. Use “Select All” to 
verify that it also makes sense for all the images in the set.  

7. Repeat steps 1 through 6, zooming in on different parts of the image until all obvious and 
unambiguous plant leaf pixels are classified as “Green.” 

8. Check other images in the set to make sure all unambiguous elements in the set are classified as 
“Green”. 

9. After classifying the obvious/easy plant elements, classify the obvious and unambiguous sky 
elements. Proceed in the same manner as for plant matter (steps 1 through 8 above). 
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G.9 Strategies for classifying additional pixels 

After classifying the easily identifiable plant and sky elements in an image set, finding additional pixels to 
classify can be difficult. The strategies below will aid in identifying and classifying additional pixels. See 
the digital tutorial “Classifying Pixels” for demonstrations on using these techniques. In general, it is 
best to err on the side of caution: Classify a pixel/color as “Mixed” rather than misclassify it as “Sky” 
or “Green”. 

1. Look closely at the edges of foliage elements for pixels to assign to the “Green” or “Sky” classes. 

• Toggling back and forth between true colors and classified colors is a good way to locate 
unassigned pixels.  

• Compare the true colors of the unclassified pixels to those in the color palette. If they are 
not similar, then leave the pixels in the “Mixed” class. 

2. Use the color palette to identify colors to move from “Mixed” to either the “Green” or “Sky” 
class if it seems to make sense. In particular look for: 

• Bright/light grays to move into the “Sky class.  
• Dark greens, very dark greys, and black to move into the “Green” class. 
• Focus particularly on colors with red dots, as these represent the greatest number of pixels.  

3. Look at the color palette. Does anything look out of place? If yes, move it to the “Mixed” class.  
4. Look at all the images in a set: There may be a group of easily classified pixels in one image that 

is not present in the other images. 
5. Determining when you are finished with pixel classification: 

a. Keep an eye on the percent of pixels assigned to “Mixed” category. Once it is down to 15% - 
20%, classification is complete (Figure 6). 

b. Click “Done” at the bottom of the image grid. 
c. Click “Yes” 

• A series of computations occur. When they are done, the screen returns to the CanEye 
launch screen.   

• LAI results from the image analysis are stored in a subfolder located in the folder with 
DHP images that was initially selected. 
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Figure 6. Example of an upward-facing hemispherical image 
successfully classified into sky (orange) and plant material (purple). 
Grey represents ambiguous pixels in the “Mixed” category that the 
user has not classified. 
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SOP H Data Entry and Verification 

As a best practice, field data should be transcribed into the data ingest workbook (RD[09]) within 7 days 
of collection. However, given logistical constraints, the maximum timeline for entering data is within 14 
days of collection. See RD[04] for complete instructions regarding manual data transcription. 

Results from the CanEye image analysis are automatically stored in a subfolder within the “processed” 
folder created earlier. Data from the CanEye Excel output file are manually transcribed into the NEON 
Data Ingest Workbook for Digital Hemispherical Photos (RD[09]). 

1. Navigate to the folder containing the CanEye output files: 

\\...\boutID\plotID\imageType\processed\CE_P180_processed\ 

2. Open the Excel file (.xls) that CanEye produced. There should be several tabs within this file. 
3. Click on the “PAI, ALA” tab. These data are calculated LAI values for the entire plot. 

Note: CanEye actually reports “PAI” – i.e. Plant Area Index – rather than LAI. PAI is roughly 
equivalent to LAI, but includes the contribution of non-leaf plant parts such as twigs, branches, 
and some trunks. In practice, LAI is rarely calculated, and PAI is reported and referred to as LAI. 

4. Transcribe values from the “PAI, ALA” tab into the “plotLAI” field in the “lai_perPlot_in” table in 
the Ingest Workbook (RD[09]). Consult Table 22 to determine which values in the “PAI, ALA” tab 
are required (see Figure 7 for an example “PAI, ALA” tab). 

Table 22. Guidelines for transcribing LAI output from the CanEye Excel file to the NEON Data 
Ingest Workbook. 

Camera Orientation Vegetation Type Transcribed Value 

Downward All Column = True PAI 
Row = CE V6.1 

Upward 

Forest overstory (> 3m 
average height for the plot) 

Column = True PAI 
Row = CE V5.1 

All others Column = True PAI 
Row = CE V6.1 

5. Record the number of images CanEye analyzed in the “imageNumber” field in the 
“lai_perPlot_in” table. 
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6. Transcribe values from column C in the “P57 results” tab into the “pointLAI” field in the 
“lai_perPoint_in” table in the Ingest Workbook (RD[09]). These data are calculated LAI values for 
each image (and hence each pointID). 

• Assign the appropriate “pointID” value to each value of “pointLAI”. 
• To assign the correct “pointID” to values of “pointLAI,” use previously entered data from th 
• e “associatedMedia” and “pointID” fields in the “dhp_perImageFile_in” ingest table. 

7. Once data have been transcribed from all plots for a given bout, create a .csv file for each ingest 
table containing only the newly entered data in that table. These .csv files will be processed by 
the NEON CYI team. 

 
Figure 7. Example CanEye output from the “PAI, ALA” tab. Values that may be 
transcribed are circled in red. 
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8 REFERENCES 

N/A  



 Title: TOS Protocol and Procedure: Measure of Leaf Area Index Date:  11/03/2014 

NEON Doc. #:  NEON.DOC.014039 Author: C. Meier Revision:  E 

 
 

 2014 NEON Inc. All rights reserved. 
 

Page 46 of 65 

APPENDIX A QUICK REFERENCES 

A.1 Taking Hemispherical Images 

1. Determine number and type(s) of images needed for sample plot.  
2. Assess if lighting conditions are favorable. 
3. Dawn/Dusk sampling 

a. Dawn sampling: Start with upward-facing images 
b. Dusk sampling: Start with downward-facing images  

4. Take test image to assess lighting conditions.   
5. Begin on north axis, taking downward-facing photos at 2 m, 6 m, and 10 m. 
6. Check each image for exposure. Delete and reshoot as needed. 
7. Record Point ID and other required information on datasheet.  
8. Continue taking downward-facing images, moving sequentially to east, south, and then west 

axes, always starting at the photo point closest to the plot origin. 
9. Take images of other required cameraOrientation (if needed) and test image.  
10. Check for correct exposure, white saturation, and focus.  
11. Begin on north axis, take pictures sequentially at 2 m, 6m, and 10 m and continue sequentially 

to east, south, and then west axes. 
12. Check white saturation, exposure, and focus of each image. Delete and reshoot as needed. 
13. Record Point ID and other required information on datasheet.  
14. Transcribe datasheet and download camera images to NEON computer. 
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APPENDIX B REMINDERS 

B.1 Getting Ready for Image Collection 

At least two days before field effort: Make sure… 

 Fisheye lens is clean and not scratched. 
 Primary and backup batteries for camera are charged. 
 Default camera settings are correct.  See table below. 
 Mirror-site compass is set to correct declination. 
 Sample locations are uploaded to GPS. 
 You can accurately pace 4 m. 
 LAI Field QC datasheets are printed. 
 All equipment is gathered and in working order. 

B.2 Taking Quality Hemispherical Images 

When you arrive at site: Make Sure… 

 Direct sunlight is NOT visible on foliage. 
 It is not raining. 
 Backpacks and other gear are placed outside the plot and out of view of the camera. 
 There are no ferrous metal objects with 50 cm of the site-mirror compass. 
 You’ve determined number and type of photographs needed. 

B.3 When taking images: Check that… 

 Camera settings are correct.  
 Downward-facing image: Aperture-priority mode, focus automatic 
 Upward-facing image: Manual exposure mode, focus manually set to infinity (∞). 
 Proper lighting conditions are present. 
 Downward-facing photos are taken before upward-facing photos. 
 Test photo indicates proper exposure. 
 Images are taken sequentially at 2 m, 6 m, and 10 m from plot origin, beginning on the north 

axis before proceeding to the photo-point locations on east, south, and west axes. 
 Foliage is not within 50 cm of camera lens. 
 Camera is held as close to perpendicular to ground surface as possible. 
 Quality of every image is assessed immediately after taking it. 
 Point ID and other required information are recorded on LAI field datasheet. 
 Any deviations from protocol are described in notes section of datasheet. 
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APPENDIX C ESTIMATED DATES FOR ONSET AND CESSATION OF SAMPLING 

In Table 23 below, Start Date and End Date fields are relevant to temporally-intensive LAI sampling in 
Tower plots; the Peak Greenness field represents the date range during which AOP is expected to fly 
each site, and during which spatially-intensive LAI sampling in Distributed plots is expected to occur. An 
additional contingency for Distributed plot LAI sampling is that all plots should be measured within a 1 
month window that includes the actual AOP flight date. All dates in Table 23 are estimated from MODIS-
EVI phenology data averaged from 2001-2009. See Appendix D for conversions from day of year to 
Gregorian date. 

Table 23. Site-specific sampling start and end dates for LAI timecourse sampling in Tower plots, and peak greenness sampling 
date ranges for spatially-intensive Distributed plot LAI sampling. All dates are provided in day-of-year format. Site ID values that 
are bold/italic are sites in Operations in 2014. 

Domain 
Number Site ID Start Date End Date Peak 

Greenness Additional Sampling Information 

01 
BART 120 300 170-220  
BURL 110 315 160-220  
HARV 110 300 160-220  

02 
BLAN 75 310 150-210 Variable peak greenness window; may 

end by day 180. 
SCBI 85 320 150-220  
SERC 80 325 155-220  

03 

DSNY 60 320 140-190 Variable peak greenness window; may 
begin by day 120, end by day 155. 

JERC 90 310 175-220 Variable peak greenness window; may 
end by day 195. 

OSBS 70 315 150-190 Variable peak greenness window; may 
begin by day 120, end by day 145. 

04 

GUAN 0 365 NA Year-round Tower plot sampling; 
no peak greenness. 

LAJA 0 365 NA Year-round Tower plot sampling; 
no peak greenness. 

MAME 0 365 NA Year-round Tower plot sampling; 
no peak greenness. 

05 
STEI 120 250 165-215  
TREE 120 250 165-215  
UNDE 125 285 170-215  

06 KONA 90 300 160-210 Variable peak greenness window; may 
end by day 190. 
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Domain 
Number Site ID Start Date End Date Peak 

Greenness Additional Sampling Information 

KONZ 90 300 160-210 Variable peak greenness window; may 
end by day 190. 

KUFS 75 330 160-210 Variable peak greenness window; may 
end by day 185. 

07 
GRSM 90 310 155-215  
MLBS 110 310 160-220  
ORNL 90 315 140-210  

08 
CHOC 70 335 145-200  
DELA 60 330 135-205  
TALL 75 330 135-195  

09 
DCFS 120 290 180-205  
NOGP 115 290 170-200  
WOOD 120 290 180-210  

10 

CPER 90 350 165-210 Variable peak greenness window; may 
begin by day 135, end by day 165. 

RMNP 120 285 180-210  

STER 90 270 150-190 Variable peak greenness window; may 
end by day 155 (early crop harvest?) 

11 
CLBJ 60 325 135-180 Variable peak greenness window; may 

end by day 160. 
KLEM 75 310 130-165  
TBD     

12 
BOZE 105 285 TBD  
PARA 105 285 TBD  
YELL 120 280 165-190  

13 
MOAB 85 300 165-225  
NIWO 140 270 190-220  
TBD     

14 

JORN 80 320 185-245 Variable peak greenness window; may 
begin by day 140, end by day 210. 

SRER 150 330 190-240 

Variable start and end dates, pay 
attention to within-year phenology. 
Variable peak greenness window; may 
begin by day 90, end by day 120. 

TBD     
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Domain 
Number Site ID Start Date End Date Peak 

Greenness Additional Sampling Information 

15 
ONAQ 75 280 130-170 Variable peak greenness window; may 

begin by day 100, end by day 135. 
RBUT 105 310 150-190  
TBD     

16 
ABBY 110 300 165-205  
THAY 110 300 165-205  
WREF 115 290 165-210  

17 
SJER 270 155 65-95 

Mediterranean system: End Date and 
Peak Greenness dates are in same 
growing season as Start Date, but next 
calendar year. Start and End dates are 
variable, pay attention to within year 
phenology. 

SOAP 90 290 155-185  
TEAK 120 300 180-205  

18 
BARO 175 220 195-210  
TOOL 160 240 185-205  
TBD     

19 
DEJU 130 250 170-210  
HEAL 135 245 180-210  
POKE 135 250 180-205  

20 

OLAA 0 365 NA Year-round Tower plot sampling; 
no peak greenness. 

PUFO 0 365 NA Year-round Tower plot sampling; 
no peak greenness. 

PUGR 0 365 NA Year-round Tower plot sampling; 
no peak greenness. 
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APPENDIX D DAY OF YEAR CALENDARS 

D.1 Day of Year Calendar for Non-Leap Years 
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D.2 Day of Year Calendars for Leap Years 
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APPENDIX E CONFIGURING THE NIKON D800 FOR HEMISPHERICAL PHOTOGRAPHY  

The Nikon D800 must be configured appropriately in order to take satisfactory images for LAI analysis 
with the CanEye software. There are several suites of settings that need to be adjusted prior to shooting, 
and these can be grouped into a few general categories:  

• Settings adjusted with physical buttons and knobs 
• Settings adjusted with the camera software (playback, shooting, and setup menus). 
• A customizable menu called “My menu” can also be modified so that frequently adjusted 

settings are readily available. 

E.1 Settings Adjusted Prior to Field Work 

SHUTTER-RELEASE MODE 

Desired setting = S (single shot). To adjust, press the button near the left control knob (below left), and 
rotate the outer-ring of the control knob until “S” is selected (below right). 
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IMAGE QUALITY 

Desired setting = RAW. To adjust, press the “QUAL” button on the left control knob (below left), and 
rotate the primary wheel until “RAW” is displayed in the top LCD (below right). 

 

WHITE BALANCE 

Desired setting = Auto. To adjust, press the “WB” button on the left control knob (below left), and rotate 
the primary wheel until “WB A” is displayed in the top LCD (below right). 
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METERING MODE 

Desired setting = Matrix Metering. To adjust, rotate the outer ring of the “AE-L/AF-L” button to the 
center position (see below). 

 

FISHEYE LENS F-STOP RING 

Newer models of the Nikkor 16mm Fisheye lens may have a manually-adjustable f/stop ring, and a 
switch that toggles manual lens control versus control through the D800 body. We wish to maintain 
control of f/stops through the D800 body. To do this: 

1. Rotate the f/stop ring on the lens to f/22 (the “f22” text printed on the lens should be red). 
2. Toggle the lens switch to the red dot. This will prevent further manual movement of the lens 

f/stop ring, and allow changes to f/stops to only occur via the camera. 

  



 Title: TOS Protocol and Procedure: Measure of Leaf Area Index Date:  11/03/2014 

NEON Doc. #:  NEON.DOC.014039 Author: C. Meier Revision:  E 

 
 

 2014 NEON Inc. All rights reserved. 
 

Page 56 of 65 

PLAYBACK DISPLAY OPTIONS 

Desired settings = show “Overview”. With this option enabled, it is possible to evaluate the histogram of 
each image after it is acquired. To adjust, 

1. Press the “Menu” button, then use the “Multi-selector” button (circled below-right) to navigate 
to “Playback Menu  Playback display options”. 

 

2. Use the Multi-Selector to check the box next to “Overview”. 
3. Navigate to “Done” and press the “OK” button (the latter is located in the lower left of the 

image above). 
4. To view histogram information for an image, press the “Play” button (circled in red below). 

 

5. Use the L and R arrow keys on the Multi-Selector to select the desired image. 
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6. Press the Up and Down arrow keys on the Multi-Selector to bring up the “Overview” histogram 
information (below). The red circle indicates the file name. 

 

FILE NAMING 

Desired setting = DXX, where XX = the unique NEON Domain number. To adjust, press the “Menu” 
button, and select “Shooting MenuFile naming”. Enter the appropriate alpha-numeric characters. 
When finished, “DSC” should no longer be displayed, and your custom characters should be. 
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COLOR SPACE 

Desired setting = sRGB. To adjust, press “Menu”, and select “Shooting Menu  Color space”. Select 
“sRGB” and press the “OK” button. 

 
ACTIVE D-LIGHTING 

Desired setting = AUTO. To adjust, press “Menu”, and select “Shooting MenuActive D-Lighting”. Select 
“Auto” and press the “OK” button. 
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HIGH ISO NOISE REDUCTION (NR) 

Desired setting = Normal. To adjust, press “Menu” and select “Shooting Menu High ISO NR”. Select 
“Normal” and press the “OK” button. 

 

ISO SENSITIVITY SETTINGS 

Desired setting: Minimum shutter speed = 1/30; Maximum sensitivity = Hi2. To adjust, use the “Multi-
Selector” and press the “OK” button on the desired settings. 
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TIME ZONE AND DATE 

The following settings must be adjusted: 

• Time Zone 
• Local time and date 
• Date format = Y/M/D 
• Daylight savings time – i.e. ON/OFF depending on time of year 

 

IMAGE AUTO- ROTATION 

Desired setting: Auto-Rotation = OFF. Required in order to force all captured images to Landscape 
orientation for compatibility with CanEye analysis. To adjust, use the multi-selector to navigate to 
“SETUP MENU Auto image rotation  OFF” and press the “OK” button. 
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CUSTOMIZING “MY MENU” 

Any settings for which quick access is desired can be added to the customizable “My Menu” screen 
(image below). To add a setting to “My Menu”, 

1. Press “Menu”, then select “My Menu  Add items” (image below). 
2. Scroll through the available settings menus until you find the setting you want to add to “My 

Menu”. 
3. With the setting highlighted, press the “OK” button. 
4. Press “OK” again. The “My Menu” screen should now be modified. 
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E.2 Settings Adjusted in the Field 

EXPOSURE MODE 

To adjust, press the Mode button, and rotate the primary wheel until the top LCD shows the desired 
mode (A or M, depending on camera orientation that will be used).  

 

AUTO FOCUS MODE (DOWNWARD-FACING PHOTOS) 

Desired setting = AF-S Auto. To adjust, 

1. Move focus switch to “AF”, then press and hold the button in the middle of the switch (below 
left). 

2. Spin the primary and secondary wheels so the top LCD reads “AF-S” with “auto” above (below 
right). 
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MANUAL FOCUS MODE (UPWARD-FACING PHOTOS) 

Desired setting = Manual. To adjust, set the focus switch to “M” (below left), and rotate the focus ring 
on the lens to “∞” (below right).  

 

ISO (SENSOR LIGHT SENSITIVITY) 

• Downward-facing DHPs: Desired setting = “ISO-auto”, initial ISO = 400. To adjust, press the “ISO” 
button on the left control knob (below left), then rotate the secondary wheel until “ISO-auto” is 
displayed (below right). Then, still pressing the “ISO” button, rotate the primary wheel until ISO 
= 400 is displayed in the top LCD. 

• Upward-facing DHPs: Desired setting = “ISO” (manual), initial ISO = 6400. To adjust, press the 
“ISO” button on the left control knob (below left), and rotate the secondary wheel until “ISO” is 
displayed (not “ISO-auto”). Then, still pressing the “ISO button, rotate the primary wheel until 
ISO = 6400 is displayed in the top LCD. 
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APPENDIX F DATASHEETS 

The following datasheets are associated with this protocol: 

Table 24. Datasheets associated with this protocol 

NEON Doc. # Title 
NEON.DOC.001575 Datasheets for TOS Protocol and Procedure:  Measurement of 

Leaf Area Index 
NEON.DOC.001398 NEON Raw Data Ingest Workbook for TOS Digital 

Hemispherical Photos 
  

These datasheets can be found in Agile or the NEON Document Warehouse. 
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APPENDIX G SITE-SPECIFIC INFORMATION 

N/A 
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